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Introduction

Introductory lecture

Afterwards we have a practical

Basical knowledge to follow this Winter School and work with our
packages

Ask questions!

·

·

·

·
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I will also ask you questions during the lecture!

-Start this week awesomely, by showing off how smart you are!

-Get MAD respect
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What is R?

R is a statistical programming language

It is open-source

·

Statistical analysis

Data visualization

Data mining

General programming

-

-

-

-

·

Free as in "free beer"" and "free speech"

Reproducibility!

Large active community around R

Many contributed packages

-

-

-

-
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Why R?

Free

Extremely powerful

State of the art statistical methods

State of the art visualiations

·

·

·

For many analyses, R is simply the only choice of software!-

·
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AND: easy to learn!

For a programming language…. 
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Installing R and RStudio



Installing R and RStudio

R

RStudio

Always use R from within RStudio!

·

This is the base programming language

Downloadable from http://cran.r-project.org/

It gives a program called R or RGui which we will never use

-

-

-

·

New and very good GUI for R

Downloadable from
http://www.rstudio.com/products/rstudio/download/

-

-

·
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First use of R



First use of R

We will use the environment RStudio for our work in R

RStudio has 4 panes:

Anything following a # symbol is treated as a comment!

·

·

Console This is the actual R window, you can enter commands here
and execute them by pressing enter

Source This is where we can edit scripts. It is where you should always
be working. Control-enter sends selected codes to the console

Plots/Help This is where plots and help pages will be shown

Workspace Shows which objects you currently have

-

-

-

-

·
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To change the layout of panes in RStudio, fo to Tools -> Global Options ->
Pane Layout. Make sure you set it like this:
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The R console
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The R console

The console pane is where R operates

In the console pane, we can type commands and press enter to have R
evaluate them

The arrow-up key lets us go back to a previous command

This is how R works, we write commands for R to evaluate

·

·

To ask R the answer to , we can type in 1 + 1 and press enter:- 1 + 1

-

·

·

Commands can be as simple as 1 + 1 or much longer encoding an
entire data analysis

-
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In the sheets, we use gray boxes to demonstrate commands we send to R.
The values that R returns are shown underneath the gray boxes followed by
the ## symbols.

For example, the command:

will be referred to in the sheets as:

1 + 1

## [1] 2
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Comments in R

1 + 1 # Here I sum 1 and 1!

## [1] 2

The # sign is used because R stops evaluating any command whenever it
sees #

·

Everything after # is not an R command.

# can be used as comments to clarify your code

-

-

Do this as often as you can!-
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The source pane
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The source pane

Often, you need to evaluate many commands sequentually

You want to be able to save these commands so that you can later reuse
them

To do this, you need to write an R script

R scripts are written and edited in the source pane

·

A command to read the data

Comands to transform the data

Commands to plot the data

Commands to analyze the data

…

-

-

-

-

-

·

·

Plain-text file with the extension .R that contains all your codes-

·
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Create a script using file -> New File -> R script:
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Save the script using file -> Save as:

Save scripts with the extension .R.

Save your scripts often!

·

·

control+S-
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Type all your commands into the script:
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Select the commands you want to evaluate:
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Press the run button or control + enter on your keyboard (command + enter
for Mac users)
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Now the command is sent to and evaluated in the R console!
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Hermione Question

What happens if I only change stuff in the Source panel?
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Use R as calculator

1 + 1

## [1] 2

(10 * 20) / 100

## [1] 2

exp(1.5 * (2.1 - 1.8)) / (1 + exp(1.5 * (2.1 - 1.8)))

## [1] 0.6106392
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Objects



Assign and use objects

The <- operator can be used to store values into objects

an object can contain anything in R

R expressions that are not stored in an object are printed

·

An object can be given an arbitrary name

Alternatively = can be used to do the same thing

-

-

·

·
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You can assign the number 1 to an object which I call a:

a <- 1
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You can assign the number 1 to an object which I call a:

Now whenever I ask R What a is it gives me 1:

a <- 1

a

## [1] 1
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You can assign the number 1 to an object which I call a:

Now whenever I ask R What a is it gives me 1:

You can use this object in calculations:

a <- 1

a

## [1] 1

a + 1

## [1] 2
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You can overwrite the object a with a new value:

a <- 10 
a

## [1] 10
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You can overwrite the object a with a new value:

You can even overwrite a using the old value of a:

a <- 10 
a

## [1] 10

a <- a + 1 
a

## [1] 11
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You can overwrite the object a with a new value:

You can even overwrite a using the old value of a:

a <- 10 
a

## [1] 10

a <- a + 1 
a

## [1] 11
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Hermione question

What happens if I now type a again?
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Or assign other objects:

b <- a + 10 
a + b

## [1] 32
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Objects can have any name you want:

anyNameYouWant <- 10 
anyNameYouWant

## [1] 10

It is recommended to use informative object names

Use camel case

·

sampleSize

rawData

nMales

-

-

-

·

Start object name with lowercase letters, start new objects with
lowercase and capitalize every word

-
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Object Modes

There are different types of objects in R:

There are called modes

To request the mode of object x use mode(x)

·

numeric

character

logical

-

-

-

·

·
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The numeric mode stores numbers:

numericObject <- 115 
mode(numericObject)

## [1] "numeric"
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Numbers

The numeric mode stores numbers:

You can use numbers in mathematical expressions:

numericObject <- 115 
mode(numericObject)

## [1] "numeric"

numericObject + 10

## [1] 125
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Strings

Anything between single or double quotation marks is stored as a
character, which can be used to encode strings:

characterObject <- 'this is a string' 
mode(characterObject)

## [1] "character"

characterObject2 <- "this is also a string" 
mode(characterObject2)

## [1] "character"
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Strings

You can not do mathematical expressions with character strings, even when
the string looks like a number!

a <- '1' # Make a a character 
a # a looks like a number

## [1] "1"

mode(a) # But is not a number!

## [1] "character"
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Hermione Question

What happens now if I do a + 1?
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Logicals

The logical mode indicates a boolean object which can only be true (TRUE)
or false (FALSE):

logicalObject <- TRUE 
mode(logicalObject)

## [1] "logical"

Shortcuts for TRUE and FALSE are T and F·

Avoid using these shortcuts!-
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Logicals

You obtain a logical result if you ask R a comparison test:

1 == 1 # Is 1 equal to 1?

## [1] TRUE

1 < 2 # Is 1 smaller than 2?

## [1] TRUE

1 >= 2 # Is 1 greater or equal to 2?

## [1] FALSE
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Transforming modes

I can use functions named as. followed by the name of the mode to
transform objects into a different mode:

"1" + 1

## Error in "1" + 1: non-numeric argument to binary operator

as.numeric("1") + 1

## [1] 2
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Vectors



Vectors

A vector is an object that stores multiple values of the same mode

Use c(...) to manually create a vector

A colon can be used to create an integer sequence

·

·

For example, c(1,2,3) creates the vector - [ ]1 2 3

·

52/92



Vectors

Create a vector using c(...):

numericVector <- c(1, 5, 10) 
numericVector

## [1]  1  5 10
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Vectors

Create a vector using c(...):

To create a sequence use a colon:

numericVector <- c(1, 5, 10) 
numericVector

## [1]  1  5 10

1:10

##  [1]  1  2  3  4  5  6  7  8  9 10
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Indexing

indexing means you want a subset, or a single element, of a vector

You can index a vector in R by using square brackets [ and ]

·

·

Follow the name of a vector with square brackets

Put in the square brackets:

-

-

A vector containing numbers of the elements you wish to keep-
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a <- c(2,4,6,8,10) 
a

## [1]  2  4  6  8 10

a[5] # Get the fifth element

## [1] 10
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Hermione Question

What do you think happens if I do a[c(1,5)] ?
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All elements of a that are lower than 5:

a[a < 5]

## [1] 2 4
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age <- c(22,20,28,25,32,21,25) 
gender <- c('male','male','female','female','male','female', 'male') 

# Age of males: 
age[gender == "male"]

## [1] 22 20 32 25

# Age of females: 
age[gender == "female"]

## [1] 28 25 21
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Functions

A function is a small program, it takes input, does something and gives
you output

It is always of the form name(argument, argument, argument, ...)

A documentation can be found for every function using ?name

You need to know the exact name of the function you want to use

·

·

·

The documentation tells you what you need to put into a function
and what comes out of it

-

·

Reference card

Use Google!

-

-
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Functions

a <- c(5, 2, 10, 1) 
# Compute mean of v1: 
mean(a)

## [1] 4.5

# Compute sum of v1: 
sum(a)

## [1] 18

# Help pages of these functions: 
?mean 
?sum
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Packages

Packages are extensions contributed to R containing extra functions

Packages can be installed using install.packages()

Afterwards they can be loaded using library()

·

Stored on the Comprehensive R Archive Network (CRAN)

Over 5000 contributed packages! All containing functions

-

-

·

Needs to be done only once-

·
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Packages

# Install package "qgraph" 
install.packages("qgraph") 

# Load package "qgraph": 
library("qgraph")
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Packages give you new functions to do anything

library("RXKCD") 
getXKCD(285)
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Many state of the art analyses have been implemented as R packages:

Package Description

lavaan Structural Equation Modeling

lme4 Multi-level generalized linear models

glmnet Regularized generalized linear models

depmixS4 Latent (hidden) Markov models

huge Graphical model selection

BayesFactor Bayesian analyses

ltm Item-response theory
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Matrices

A very important function for this course is matrix(). It creates a matrix,
which is basically a two dimensional table.

Technically, a matrix is a vector with two dimension attributes

Rows indicate horizontal lines of cells

Columns indicate vertical lines of cells

The first argument of matrix is a vector to fill the matrix with, the second
argument the number of rows and the third argument the number of
columns (see also ?matrix)

Again they can be indexed with square brackets, but now need both row
and column information, separated by a comma

·

·

·

·

·

·
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Matrices

# A matrix: 
m <- matrix(1:9, nrow=3, ncol=3) 
m

##      [,1] [,2] [,3] 
## [1,]    1    4    7 
## [2,]    2    5    8 
## [3,]    3    6    9
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Indexing matrices

# Index first row second column: 
m[1,2]

## [1] 4

# Overwrite an element: 
m[3,3] <- 0 
m

##      [,1] [,2] [,3] 
## [1,]    1    4    7 
## [2,]    2    5    8 
## [3,]    3    6    0
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Order of indexing matrices

RC -> Roman Catholic
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Indexing matrices

# First row and all columns: 
m[1,]

## [1] 1 4 7

# First 2x2 block: 
m[1:2,1:2]

##      [,1] [,2] 
## [1,]    1    4 
## [2,]    2    5
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Lists

The list() function can be used to create a list

This is an object that can contain other objects

To index a list use double square brackets, or a dollar sign (see example
on next slides).

·

·

·
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Lists

# A vector: 
v1 <- c(5,10,1,3) 
v1

## [1]  5 10  1  3

# A matrix: 
m1 <- matrix(c(5, 2, 10, 1),2,2) 
m1

##      [,1] [,2] 
## [1,]    5   10 
## [2,]    2    1

# Put them in a list: 
l1 <- list(v1 = v1, m1 = m1)
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Lists

str(l1)

## List of 2 
##  $ v1: num [1:4] 5 10 1 3 
##  $ m1: num [1:2, 1:2] 5 2 10 1
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Indexing lists

# Index the vector v1: 
l1$v1

## [1]  5 10  1  3

l1[['v1']]

## [1]  5 10  1  3

# Change an element in the matrix m1: 
l1$m1[2,2] <- 0 
l1$m1

##      [,1] [,2] 
## [1,]    5   10 
## [2,]    2    0
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Data frames

The data.frame() function can be used to create a data frames

A data frame is a combination of a matrix and a list

This is the structure you will use when working with data

Very similar to how data is stored in SPSS!

·

·

Looks like a matrix and can be indexed as one

Contains variables as each column, which can be indexed as in lists

-

-

·

·
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Data frames

# A character vector: 
sex <- c("male","female","male","female") 

# A logical vector: 
exp <- c(TRUE,TRUE,FALSE,FALSE) 

# 2 numeric vectors: 
A <- c(5,10,1,3) 
B <- 1:4 

# Put them in a data frame: 
df1 <- data.frame(sex=sex,exp=exp,A=A,B=B)
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Data frames

df1

##      sex   exp  A B 
## 1   male  TRUE  5 1 
## 2 female  TRUE 10 2 
## 3   male FALSE  1 3 
## 4 female FALSE  3 4
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Indexing data frames

# Index the vector sex: 
df1$sex

## [1] male   female male   female 
## Levels: female male

df1[['sex']]

## [1] male   female male   female 
## Levels: female male

# Subset of the data containing only A and B: 
df1[,c('A','B')]

##    A B 
## 1  5 1 
## 2 10 2 81/92



Correlation matrix

Very important in this course is the function cor(), which takes a data frame
as input and computes a correlation matrix. The function cov computes the
covariance.

# Covariance matrix 
cov(df1[,c('A', 'B')])

##          A         B 
## A 14.91667 -2.500000 
## B -2.50000  1.666667

# Correlation matrix 
cor(df1[,c('A','B')])

##            A          B 
## A  1.0000000 -0.5013947 
## B -0.5013947  1.0000000
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Reading and writing datasets in R



Reading and writing datasets in R

The best way to store data in R is to use plain text files

These can be read with:

Look at what the data looks like!

Other file types can be read. Check out read.spss in the foreign
package!

·

Often with the extension .txt or .csv

Can be opened in RStudio!

Can be exported from Excel!

-

-

-

·

read.table, read.csv and some others

These are the same function with different defaults!

-

-

·

·
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file <- file.choose() # Choose the right file 
read.table(file, header=TRUE, sep = ",")

##      sex   exp  A B 
## 1   male  TRUE  5 1 
## 2 female  TRUE 10 2 
## 3   male FALSE  1 3 
## 4 female FALSE  3 4

read.csv(file)
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Newest feature!

Import dataset by simply clicking
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Working Directory

Reading and writing files in R is done from the working directory

Can be set with setwd() or requested with getwd()

Or from the menu: session -> set working directory

·

·

·
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Writing files from R

To write dataframes you can read in Excel or other programs, use
write.table, write.csv, etcetera

write.table(df1, file = "sometable.txt") 
read.table('sometable.txt')

##      sex   exp  A B 
## 1   male  TRUE  5 1 
## 2 female  TRUE 10 2 
## 3   male FALSE  1 3 
## 4 female FALSE  3 4

Files are stored in your working directory!·
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Thank you for your attention!
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Now we can get to work!
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